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Morning Sessions

The SeniorNet Mac Apple NEWS is distributed

bimonthly on 10th April, June, August, October,

December and February. You will be kept updated on

important matters with a Mini Newsletter by email

every week, in between times.

Monday, Wednesday, Thursday and Friday

10.00 am to 12 noon

—Barbara Blowes
From the President

P
If you need to bring in your computer please ring:

03 365 1979

and leave a message

Items that can be solved quickly will be $5 but

problems requiring significant time will attract up

to $20 workshop charge.

op in and have a cuppa in the learning

centre. You can get answers to computer

problems, ask questions and get advice.

to you all,

As well as the President's Weekly Newsletters

Apple NEWS will still be Published on or about

the 10th of June, August, October, December
and February.

think as a country we have done so well with the

disruption this virus has caused us all. The information

we have been given from the Government all through
I

has been excellent. Correct information is what we all need, not

getting info from Social Media who are inclinded to exaggerate

the truth.

For me it's been such a surreal time making you very wary of

what you do and where you go.

I have missed the contact I have at the socials; I enjoy talking to

you all. Hopefully, we will safely be able to open up in July.

One thing in a lockdown situation is that I have finished a lot of

things that have been put away for a rainy day, not such a big

pile any more.

I have been reading a lot of information on the latest gadgets,

good to have the time to do this and not feel guilty at all.

I have also enjoyed the Zoom contact with many people; nice to

see them and talk to them. 

CLO
SED

unti
l fur

ther
noti

ce
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Welcome to New Members

Deadline forAugust/September Apple NEWS

28th July

Please have your copy for the next Apple NEWS to me by

the above date.

Copy can be either typed straight into an email, as a Word

file or as Rich Text Format.

Digital images need to be at least 220dpi or higher (72dpi

will not reproduce well)

Please no hard returns except at the end of a paragraph.

Page

everyone

Ann Willis and Helen Marieskind

W
ell—here we are almost down to Level One, I

hope you have all survived without too much

trauma. I have tried to keep Apple NEWS

positive and upbeat in this issue and the previous one.

Unfortunately I now have to comment on the present

horrendous situation in the United States—a situation

that I have feared becoming a reality for several years.

In this issue of Apple NEWS we feature the usual items

—Members Photo Corner, Tech Tips from Pam Doughty,

Brian the Pirate's Tips. Also an article written by Lachlan

Hunter, Virtual Rememberance, an article The Letterpress

Era which briefly lists the progress of the Printing

Industry over the centuries up until the mid 20th century

and the advent of Offset Printing and the Digital Era.

Brickbats and Bouquets—a list of awards, good and bad,

during the COVID-19 Pandemic. Two new releases from

Apple—Mac Book Pro and Magic Keyboard for iPad Pro.

Zoom has taken off in a big way due to the COVID-19

Lockdown, and I have been able to attend the Zoom

Meetings that the SeniorNet Mac have been holding,

and enjoyed virtually meeting those Committee members

that I only knew by name. I found these Zoom meetings

enjoyable and informative. I have also featured a page

Introducing the SeniorNet Mac Committee for 2020/2021

(see page 5).

Most importantly on page 6—I have outlined where we

will be once we move to Level One. As this issue will be

sent out prior to the new level being finalised, see the

President's Weekly Newsletters for updates. 
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Our Sponsors

Also in association with:

The Federation of NZ SeniorNet Societies

Advertisers
WANTED

• Web Advertising on our Web Site

• Apple NEWS Advertising

• Reasonable Rates: For prices contact:

Customer Services

03 365 1979 services@seniormac.org.nz

IMPORTANT
INTERNET BANKING

Our Direct banking number is 020816-0376043-00

PLEASE when paying monies to SeniorNet Mac, include as

reference either your Name or Membership Card number.

We are receiving credits from time to time from unknown

members. We have no way of telling who they are from.

Your Membership card has a unique number and should begin

with the figure 4

Elizabeth Chesney

Treasurer@seniormac.org.nz

Cookin’ with

—Favourite Cotswold Recipes, compiled by Dorothy Baldock

Apple User Group
Canterbury Apple Users

is a subgroup of Christchurch SeniorNet Mac Inc. and meets
on the last Wednesday of each month at

7.30 - 9.30pm in the SeniorNet Mac Rooms,

41 Essex Street, Christchurch.

A heated room with all conveniences, tea/coffee and bikkies.

FREE to SNM members. General public $4.00

Meetings will disscuss users' problems and review recent

announcements and news relating to Apple products. All

welcome.  �

FRIAR'S OMELETTE

454 grams cooking apples, peeled, cored and sliced.

90 grams butter.

90 grams granulated or soft brown sugar.

Rind of half a lemon with 1 teaspoon lemon juice

or ½ teaspoon ground nutmeg.

2 eggs beaten.

155 grams fresh white breadcrumbs

Set oven to 190°. Butter a 855 ml to 1.140ml pie dish. Cook

together the apples, butter, sugar, lemon rind and juice or the

nutmeg, in a saucepan until soft, then beat to make a thick

purée. Stir in the beaten eggs. Place half the breadcrumbs in

the pie dish, spread the apple mixture over, then top with the

remaining breadcrumbs. Dot with butter and sprinkle with a

little extra sugar and cook for 30 to 40 minutes. Serve hot

with custard or cold with whipped cream. Serves 4.

The name of this dish is nothing to do with the church, but is a

corruption of “fraise”, the medieval version of an omelette.

This is a very early version of Apple Charlotte.

CLO
SED

unti
l fur

ther
noti

ce
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SeniorNet Mac Committee 2020/2021

Elected Committee Members

Co-opted Committee Members

Principal Executive Officers

Wendy Perkins

Introducing

Mary Nicholson

Barbara Blowes

President

Elizabeth Chesney

Secretary/Treasurer

Charlie Millar

Vice President

Christene Berry

Health & Safety/Security

Brian Henderson

Fundraising

Barbara Robinson

Services

Bruce Perkins

Membership

Robin Harrington

Systems

Grace Adams

Bookings

Ross Clendon

Legal Adviser

Ross Beach

Editor Apple NEWS

Erika White

Events

Derek Brown
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Neil’s talk is about his past involvement with facilitating men’s

‘Stopping Violence Programmes’, the background to those

programmes, and an outline of the session structures and

content on the course. Examples of specific exercises,

challenges and assignments, used in the process, may be

shown or explained.In my working life I have been a Registered

Psychologist, working 6 years in the psychiatric field, 10 years in

Vocational Rehabilitation and 25 years as a Counselling

Psychologist with a wide variety of clients. Within that time I

was spending more and more time working with men who

engaged with abusive behaviours and I became involved with

‘Stopping Violence Services’ facilitating groups. Apart from

group work I also worked on contract with the Ministry of

Justice providing ‘Stopping Violence Programmes’ to men who

were subject to Protection Orders and were referred by the

Courts.

I have been married to Cathy for 48 years and we have 3 adult

children - we are lucky enough to have 2 of our children and

their families living very close; thus we are very hands on

grandparents. My other interest is tramping and skiing and

Cathy and I are keen gardeners and bridge players. 

28th July

Neil McPherson

“My 17 years in the Ring”

Guest
Speaker

✾ If and When we move to Level One—we will

be able to socialise without social distancing—this

means we can resume our SeniorNet Mac Socials

and Luncheons. We will have our first Social and

Luncheon since February at the Cashmere Club on

Tuesday, 28th July (this will be confirmed and

updated in the President's weekly Newsletters).

The Guest Speaker for July will be Neil McPherson

(see details below). The Guest speakers for August

and September will be announced in the August/

September Apple NEWS together with the dates

for those Socials and Luncheons.

✾ We will need to observe Contact Tracing and

Hand Sanitising and follow the rules for such as

determined by the Cashmere Club, and the

Goverment guidlines.

✾ The Learning Centre at 41 Essex Street is still

closed until further notice, and you will be kept

updated in the President's weekly Newsletters.

✾ SeniorNet Mac tuition is still available on a

one to one basis or as a group via Zoom sessions.

✾ Workshops—these will resume at a later stage

once we move into Level One and and it is possible

to safely teach on a one to one basis. Margaret

Hatton has been running a successful Photography

workshop via Zoom, and we hope that she can

continue to do so. You will be updated as soon as

we are able to open the Learning Centre.

✾ NB:all of theabove isstill subject tochange—
andwewill keepyouupdated in theWeeklyNewsletters

andonourwebsite,www.seniormac.org.nz 
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Top Left: Castle on riverMain,

Germany 2019.

Top Right: Nuremberg Germany 2019.

Middle Left: Cathy and Neil,

Budapest 2019.

Middle Right: Amsterdam 2019.

Bottom: Cathy and Neil,

Regensburg, Germany 2019.

Photos courtesy:

Cathy McPherson

Photo Corner
Members
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rom the mid fifteenth century up until the latter

part of the twentieth century printing could be

classified basically as the “Letterpress Era”—in

The presses used for the next several centuries

were basically the same as those used by

Gutenberg and Caxton, originally wooden frames

they later evolved to cast iron frames, but the

principle of transfering the printed image to paper

was the same, this principle was in use right up to

the early to mid nineteenth century when the first

rotary, flatbed and platen presses began to appear.

The Letterpress Era
—the evolution of printing over the centuries,

F
other words the type was pressed onto the paper,

hence the term “Letterpress”.

Johann Gutenberg

In 1439 Johann Gutenberg,

the inventor of the mechanical

processes which made it

practicable to print single

letters or continuous text from

indivdually cast movable

characters readily available in

quantity—thus began the

“Letterpress Era” which

covers printing for the next

five centuries.

A representation of

an early

“Gutenberg”Press.

A painting depicting Gutenberg at

work on his press.

Gutenberg was undoubtably

the first of many printers in

Europe who were working

using this method, and is

acknowleged to be the first

to use justification (even left

and right margins). In late

1473 or early 1474 William

Caxton printed the first book

in the English language, this

was printed and produced in

Bruges—he spent most of

his early life in Europe mainly

Flanders, Holland and

Zealand. In his own words

he was born in Kent,

England, but the year and

date of his birth are

unknown.

Stained glass window

showing William

Caxton, King Edward

IV and printing press

inside Saint

Margaret's Church,

Westminster, London.

Life working in a printing works in the “Letterpress

Era” was noisy to say the least with all the

machinery noise, the smell of the ink, your hands

were forever covered in ink and the residue from

handling type (which was lead based). The lighting

was primitive until the advent of the fluorescent

tube. Printing Works were basically one large room

with no walls or partitions so you were surrounded

by all the noise for eight, ten or sometimes twelve

hours a day, you stood (there were seldom any

chairs) on your feet for long hours at a time.

Earmuffs were unheard of—no wonder most of the

oldtimers had hearing problems.

An early wooden frame press. A later Cast Iron frame

press.

Compositors

at work in
a printing

works.
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To protect your clothes you wore a black apron with

a large pocket at waist level. You cleaned the ink off

the type with typewash (generally a mixture of

kerosene an metholated spirits). If you were a hand

compositor (like I was)—your tools were a type

gauge (a steel ruler with inches on one edge and

points and picas on the other), a pair of tweezers,

plus a composing or setting stick.

Two further scenes of compositors at work. White aprons and dustcoats? I don't think so! Obviously a

photo oportunity—they would not have stayed white for very long!

Your tools—composing/setting stick, tweezers, and

type gauge.

You held the setting stick in your left hand and

picked the individual letters out of the type case

with your right hand and placed them in the setting

stick to form the words. A case of type was layed

out in a uniform manner, the most common layout

was the California layout. Once you had filled your

California case layout

You picked the letters from the case and put them

into the setting stick

Handset type transferred to a galley.
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A galley of type on the press bed ready for inking.

A galley of type on the press bed being inked by a

hand roller.

setting stick with lines of type you then transferred

them to a galley (tray) and began to fill your stick

with further lines and repeated this process until

you had completed what you were setting. That

galley was then transferred to the bed of the press

that was used for proofing, you inked the type

using a hand roller, then placed a sheet of paper

over the type on the galley and pushed the bed into

the press, grasped the press handle and drew it

towards you to make your impression on the paper.

Released the press handle and withdrew the bed

from the press and gently lifted the paper from the

type, taking care not to smudge the image in the

process. You continued this process until you had

printed the required number of copies. So basically

the same principle was used from the days of

Grasped the press handle and drew it towards you

to make your impression.

Gently lifted the paper from the type taking care

not to smudge the image in the process.
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Johann Gutenberg up until

1885 when Ottmar

Merganthaler, a German

residing in America produced

his first “Linotype” machine.

In 1890 a much improved

model was available and

found ready sale in America,

Britain, and later in other

countries.

From that date Newspapers

were set from Linotype and
Ottmar Merganthaler

An early model

Linotype

machine.

no longer handset type. The type was set by

matrices and cast to form justified lines called

“slugs”. Not only did it revolutionise Newspapers,

but also Book production. Hand setting was still

used for display (i.e. posters, business cards,

invitations etc.) and headings. This trend continued

up until the 1960s and into the 1970s in some

A single matrix.

A line of

matrices ready

for casting. The

long vertical

ones are the

space bands

used to

separate the

words.

A Linotype slug after casting

A later model Linotype machine.
A galley of Linotype slugs and handset type.



Page 12Helping Seniors with Apple Technology http://seniormac.org.nz

printing works. A “Linotype” machine required only

one operator (the late Joe Adams SeniorNet Mac

member was originally a linotype operator in the

1960s/70s). Printing Works generally had two or

three “Linotype Machines”, Newspapers had banks

of up to 20 machines depending on the size of the

Newspaper. The noise was massive with the clatter

of matrices dropping from their “magazines”, the

banging and clanging of the lines being cast, the

noise of the used matrices dropping back into their

magazines.

The noise would have been horrendous! A bank of

Linotype machines in a newspaper office. Correcting a galley of Lynotype slugs.

Once type was set you proofed it—both handset

type and Linotype was “mirror image” until a proof

impression, hence the term “letterpress”.

The other advancement from the mid 19th century

into the 20th century was the printing presses, with

the advent of the “hand fed platen”, the “sheet

fed” flat bed press and the “rotary press” which

was used mainly by newspapers. After WWII the

An early model “Rotary Hoe” newspaper press.

An early model flatbed sheet fed press.

An early model hand

fed platen press.

They were generally

powered by a foot

treadle.
An example set type alongside proof of same.
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most common models were the “Heidelberg

printing presses” and the “Miele printing presses”.

“Heidelberg” were considered the “Rolls Royce”

of letterpress machines, “Vertical Miele” were

considered to be good middle of the range

letterpress machines. The Heidelberg platens were

used in most printing works in the 1950s/60s/70s;

they were very reliable and produced excellent

work. If you received a Diploma or Certificate from

either the University of Canterbury or Lincoln

College/Lincoln University between1968 to1979, I

set and printed it on a Heidelberg platen at the

Caxton Press, Landfall and other books and

publications were printed on an “Original

Heidelberg” flatbed press at the Caxton Press.

“Vertical Miele” presses were extremely noisy—

mainly because the bed moved vertically and not

horizontally like most flatbed presses—but they

The “Heidelberg” platen The “Heidelberg” cylinder press

The press room at the Caxton Press, obviously tidied

up for the photo.

The Vertical Miele.

were an excellent press between a platen and a

flatbed machine. The “death knell” of the letterpress

era came with the modern Lithographic/Offset

presses and “Cold Type” setting, the forerunner of

the “Digital Era” and the advent of “Desktop

publishing” and the birth of “Apple” 
This article was written using my knowledge

gained from 50 years in the printing trade, plus

dates and timelines taken from the “Annals of

Printing”—a chronological encyclopaedia ,“Caxton

in focus”, and research on the internet.

—Ross Beach, Editor
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Virtual Remembrance
A Personal Reflection on ANZAC Day

SeniorNet Mac Member, Lachlan Hunter

pril 25 this year was still within the level 4

lock-down to halt the spread of the COVID-

19 virus and so, for the first time since the
A

half-day holiday was legally established in 1916 (a full

day’s public holiday in 1922), there were no dawn or

other services of remembrance for people to attend.

Instead, we were invited to stand at the entrance to

our driveways just before 6 a.m. (more than an hour

before dawn - the traditional “stand-by” time in the

trenches waiting for the whistle). It was surprising

how many houses had dark figures silhouetted

before their bright living-rooms, some of them

small children. The distant sound of “The Last

Post” sounded from two directions, probably from

trumpets, more accurate than the valveless bugle.

But I was reminded of the reported reply of Charles

Upham, V.C. & bar, on whether he wished for a

State Funeral - “A bugle will do.”

Typically, attending a mid-morning event at a local

war memorial, I had noticed that crowds have been

increasing in recent years and latterly mothers with

infants in strollers or even whole families were

significant parts of the crowd. Also, the active

military element was becoming more obscure; we

would all disperse quietly at the close of proceedings

and no longer would someone bellow “Parade,

dismiss!”. However, there have been rises and falls

in attendance in the past. Sixty-three years ago, six

thousand attended the Auckland dawn service. A

constant tussle took place in the early days with the

churches, but the pattern of war memorial location

is now set, although clergy may speak or conduct

prayers. Older school pupils may read the names

of local fallen, and children’s groups participate.

Wreath-laying has become the most essential element.

The anti-war protests must have puzzled and

angered veterans but these faded at the end of the

Vietnam war in 1975, only to be replaced by anti-

nuclear protests that probably reached their peak

just after the sinking of the Rainbow Warrior in

Auckland Harbour in July 1985. Nevertheless,

ANZAC Day continued to be a focus of other

protests for peace, Maori grievances, and women’s

rights. Only in the last decade has the remembrance

with gratitude emotion dominated again.

I always find the use of Laurence Binyon’s poem

distressing. Not a war poet (he was in his mid-

forties when the Great War began), he worked all

his life at the British Museum, eventually

becoming Keeper of the Department of Prints and

Drawings, and an authority on oriental art, indeed

all fine art, and Professor of Poetry at Harvard on

retirement. He should really be remembered for

his incredible translation of Dante’s Divine Comedy

into English poetry like Dante’s Italian, just

completed in the year of his death, 1943.

In my family, it had always been said that my

great-uncle enlisted under-age (no computerised

databases with DOB and name automatically

linked in those days) and was killed at Gallipoli.
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However, my sister recently found out that he

survived the Turkish campaign but was killed on the

Somme the following year. Moreover, he was 20 at

the time of his death. Irish, and probably born there,

it is poignant that the battle of the Somme, with a

million casualties on all sides, took place only

months after the abortive Easter Rising of the IRA

against British rule.

By contrast, both grandfathers survived the First

World War, although my maternal grandfather was

mute for six months after his return. My paternal

grandfather kept a diary for six months (probably

contrary to Army regulations) and told me he had an

easy time as a truck driver, but the diary, which I

transcribed from the pencilled notebook to

computer, leaving the file with my son-in-law,

makes it hard to understand how bad a “bad time”

was if this was easy.

Of a fortunate generation, like the early Victorians, I

am conscious of the wars that afflicted the two

generations before me. A baby photograph

survives, showing my parents both in uniform, my

father a sergeant in the Medical Corps, my mother

a Captain (he had to salute her) in Queen

Alexandra’s Nursing Corps (then called Q.A.

Imperial Nursing Service/Army). “Alex” was the

long-suffering Danish spouse of Edward VII, whose

marriage occasioned the planting of the very first

commemorative tree, an oak, in the Christchurch

Botanic Gardens. It could be said that I ruined two

promising nursing careers, my mother’s by being

born, and my wife’s by taking her to Japan, where

the language barrier prevented her from practising.

The commemoration theme became so strong this

century that in 2012 the Community Fields of

Remembrance project began, ultimately with some

25 “fields” countrywide. In pre-lockdown years

Cranmer Square and the Papanui Memorial Garden

held for 7-10 days a metre grid pattern of white

crosses each marked with the name of a lost WWI

life (a 6-pointed Star of David for Jewish fallen). One

of the founders of this project was the

Passchendaele Society.

The losses on 25 April 1915 were bad enough. The

ANZACs, two divisions, were supposed to land just

north of Gaba Tepe on the far coast and cross only

7 km. to the Hellespont at the peninsula’s

narrowest part, cutting off Turkish troops at the tip,

but the Navy landed them too far north, before the

cliffs of Ari Burnu (Anzac Cove as it became) and at

least 100 New Zealanders perished this first day,

excluding those mortally wounded. Much later,

after the campaign was abandoned, and the

miraculous evacuation took place without a

casuality, the survivors re-grouped in Egypt and

then the Australians and New Zealanders were

sent to the Western Front. 1916 gave rise to one

of the century’s worst catastrophes, such that any

kind of incompetence or maladministration is now

proverbially described as “the biggest cock-up

since the Somme”. Passchendaele, 1917, was

even worse for New Zealand than Gallipoli, with a

higher death toll; the ruined town was only taken

later by the Canadians after it had ceased to be

strategically important, but its assault had already

taken many British, Australian, and New Zealand

lives. In the last month of the war, in 1918, the

New Zealand Division recorded its final casualties

in the successful assault on Le Quesnoy, occupied

since 1914.

So it is clear that, although ANZAC Day

commemorates all service overseas (mostly

peace-keeping missions now), the Gallipoli

campaign, with all its mistakes and disasters,

continues to symbolise lives sacrificed on our

behalf. The centenary, at the original location,

underlines this point. Most of those who died

there have no grave, but just a record on the Lone

Pine Memorial. An Australian soldier collected

seed from the cones of the Turkish Pine (PInus

brutia) like the “Lone Pine”, and a tree grown from

that provenance may now be seen in the Pinetum

of the Botanic Gardens in Christchurch. The last

New Zealand veteran of the campaign, Bright

Williams, died in 2003, after giving a harrowing

description of what it was like to try and recover

bodies during a truce agreed after a beserk

counter-attack that cost ten thousand Turkish

lives. Now the Second World War veterans are a

small cadre, and, as noted by Ron Marks in his

ANZAC Day speech yesterday, belong to the

group at highest risk from COVID-19.

War memorials only appeared after the First World

War, and remain a Western custom. During a tour

of Western Europe as a forestry student we were

taken, as side trips, to see “La Voie Sacrée” (the

Sacred Way) in France, a road which had plinths

bearing the helmets of French WWI soldiers at

regular intervals, and a Commonwealth War

Graves cemetery in the Netherlands, very moving

places. However, the greatest impact had come

earlier, when my wife and I, not long married, had

a camping holiday in the Black Forest region of

Germany. We waited for a bus back to town at a

war memorial in a small rural settlement. I was

astonished at the length of the inscriptions, the

sheer number of names, even though I understood

from the history of Germany, why this should be

so. Every country has living people who owe a

debt to those who have gone. 
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PRESS RELEASE
May 4, 2020

Apple updates 13-inch MacBook Pro with Magic Keyboard, double the storage,

and faster performance

Cupertino, California — Apple today updated the 13-inch

MacBook Pro with the new Magic Keyboard for the best typing

experience ever on a Mac notebook and doubled the storage

across all standard configurations, delivering even more value

to the most popular MacBook Pro. The new lineup also

offers 10th-generation processors for up to 80 percent faster

graphics performance1 and makes 16GB of faster 3733MHz

memory standard on select configurations. With powerful

quad-core processors, the brilliant 13-inch Retina display,

Touch Bar and Touch ID, immersive stereo speakers, all-day

battery life, and the power of macOS, all in an incredibly

portable design, the new 13-inch MacBook Pro is available to

order today, starting at $1,299, and $1,199 for education.2

With a sleek aluminum unibody design in space gray or silver

and weighing just 3 pounds, the 13-inch MacBook Pro is highly

portable and packed with performance and advanced

technologies.

“Whether you’re a college student, a developer, or a creative

pro, the 13-inch MacBook Pro delivers powerful performance, a

stunning Retina display, and all-day battery life in our most

portable pro notebook. Today we’re adding the new Magic

Keyboard, doubling the standard storage, and boosting

performance, making the 13-inch MacBook Pro an even better

value for our customers,” said Tom Boger, Apple’s senior

director of Mac and iPad Product Marketing. “With these

updates, our entire notebook lineup features the Magic

Keyboard for the best typing experience ever on a Mac

notebook, offers twice the standard storage than before, and

delivers even more performance.”

The new Magic Keyboard comes to the 13-inch MacBook Pro,

delivering the best typing experience ever on a Mac notebook.

New Magic Keyboard

The updated 13-inch MacBook Pro now features the new Magic

Keyboard, first introduced on the 16-inch MacBook Pro and

added to MacBook Air in March. Magic Keyboard features a

redesigned scissor mechanism with 1mm of key travel for a

comfortable and stable key feel, while the new inverted-“T”

arrangement for the arrow keys makes them easier to find,

whether users are navigating through spreadsheets or playing

games. Magic Keyboard also features a physical Escape key,

along with Touch Bar and Touch ID, for a keyboard that delivers

the best typing experience ever on a Mac notebook.

Magic Keyboard on the 13-inch MacBook Pro features a

physical Escape key, Touch ID for easy login and secure online

purchases, and Touch Bar with dynamic and contextual controls.

Double the Storage

Customers love the superfast SSDs on MacBook Pro, with

sequential read speeds of up to 3.0GB/s. The 13-inch MacBook

Pro now comes with double the storage of the previous

generation, with standard storage starting at 256GB all the way

up to 1TB, so customers can store even more photos, videos,

and files. And for pro users who need even more storage

capacity for large photo libraries and video projects, the 13-inch

MacBook Pro now offers up to a 4TB SSD.

https://www.apple.com/macbook-pro/
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With standard storage starting at 256GB all the way up to 1TB,

13-inch MacBook Pro users can store even more photos, videos,

and files.

Better Performance

The 13-inch MacBook Pro lineup now offers up to 10th-

generation quad-core Intel Core processors with Turbo Boost

speeds of up to 4.1GHz. Customers who are upgrading from a

13-inch MacBook Pro with a dual-core processor will see up to

2.8 times faster performance. The integrated Intel Iris Plus

Graphics deliver up to 80 percent faster performance over the

previous generation 13-inch MacBook Pro for 4K video editing,

faster rendering, and smoother gameplay. The new graphics

also enable users to connect to Pro Display XDR at full 6K

resolution.

With the latest 10th-generation processors, the 13-inch

MacBook Pro delivers up to 80 percent faster graphics

performance for 4K video editing, faster rendering, and

smoother gameplay.

Faster Memory and More Memory

16GB of faster 3733MHz memory is now offered as a standard

configuration on select models, and for the first time on a 13-

inch Mac notebook, customers can choose a 32GB memory

option. With 32GB of memory, users will experience better

performance while running multiple virtual machines and up to

50 percent faster performance when editing gigapixel images

in Photoshop.

Portable Design with a Stunning Retina Display

With a sleek aluminum unibody design in space gray or silver

and weighing just 3 pounds, the 13-inch MacBook Pro is both

highly portable and packed with performance and advanced

technologies. Its stunning and brilliant 13-inch Retina display

delivers more than 4 million pixels and millions of colors, along

with 500 nits of brightness and support for the P3 wide color

gamut. And with True Tone technology, the display offers a

more natural viewing experience for design and editing

workflows, as well as for everyday tasks such as browsing the

web and writing email. The 13-inch MacBook Pro also comes

with speakers that provide incredibly immersive wide-stereo

sound, Touch ID for easy login and secure online purchases,

Touch Bar with dynamic and contextual controls, and the

industry-best Force Touch trackpad for precise cursor control

and Multi-Touch navigation.

The 13-inch MacBook Pro features a brilliant Retina display

with more than 4 million pixels and millions of colors, 500 nits

of brightness, and support for the P3 wide color gamut.

Built-in Security and Privacy

The 13-inch MacBook Pro comes with the Apple T2 Security

Chip, Apple’s own custom-designed second-generation silicon,

which checks that software loaded during the boot process has

not been tampered with and provides on-the-fly data encryption

for everything stored on the SSD. This allows MacBook Pro and

any Mac with the T2 chip to deliver the most secure boot

process and storage of any computer. The T2 also protects

Touch ID information, so whether customers are unlocking their

Mac, entering an online password, or making online purchases,

their information stays safe.

Touch ID on the 13-inch MacBook Pro keeps information safe

whether customers are unlocking their Mac, entering an online

password, or making online purchases.

macOS Catalina

Every new MacBook Pro comes with macOS Catalina, the latest

version of the world’s most advanced desktop operating

system. macOS has always been at the core of the Mac

experience, and with apps such as Safari, Mail, Photos, Pages,

Numbers, and Keynote, customers have powerful tools to do

amazing things. macOS also makes MacBook Pro the perfect

companion device to iPhone, iPad, and Apple Watch with built-

in Continuity features that allow users to make and receive

phone calls without picking up their iPhone; automatically

unlock their Mac with Apple Watch; copy and paste images,

video, and text straight from iPhone or iPad to a nearby Mac;

and in macOS Catalina, extend the workspace of their Mac

using an iPad and Sidecar. Security features keep users better

protected, and Voice Control lets users control their Mac

entirely with their voice.

In macOS Catalina, users can extend their workspace and use

iPad and Sidecar alongside their new 13-inch MacBook Pro. 

Price in New Zealand is aproximately NZ $2.200

Shop around as retailers price could be different.
Also make sure that the model on offer is 2020 some
retailers try and sell off their stocks of 2019 models as

the latest 2020 model.
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Brickbats
Bouquets

and

The largest Brickbat of all goes to the Self Proclaimed

“Leader of the free World” who would rather

“Tweet” so he can villify and sack those who dare

disagree with him whilst the population of his

country suffers a “Pandemic” of “Bibical proportions”.

A large Bouquet to former President Obama for the

understatment of the century when he said the

Trump Administration's response to the Pandemic

was an “absolute chaotic disaster”.

The largest Bouquet of all to the front line Health

Workers world wide who are fighting this

pandemic 24/7 and at times in the face of lack of

equipment and leadership from their superiors.

A large Brickbat to the person of low intelligence

in the media who asked Dr Bloomfield “what is

your opinion of injecting disinfectant”.

A large Bouquet to Dr Bloomfield for his stunned

facial expression after he was asked about

injecting disinfectant.

A large Bouquet to our Prime Minister Jacinda

Ardern and the Covid-19 response team for their

sterling efforts in controlling the spread of the

virus. In spite of criticism from certain sectors of

the public, her daily updates were informative and

delivered with clarity.

A large Brickbat to the former leader of the

Opposition for his thinly veiled support for the

pandemic response, which in reality was a

smoke screen for his political point scoring.

A large Bouquet to the four and a half million

New Zealanders’ who obeyed the rules and went

into “Lockdown”. But definitely no Bouquet for

the other half a million who said “stuff you, you

can‘t tell us what we can and can't do”.

A large Brickbat to former Prime Minister Sir

John Key for gross insensitivity, who when

ordinary “kiwis” were really hurting—losing

their jobs, fighting to feed their families—and

fighting foreclosure on their homes, businesses

and mortgages, purchased an apartment in

Sydney for NZ $6 million dollars, and the next

day put it up for sale once again on the market

for NZ$ 6.5 to $7 million—if that’s not wheeling

and dealing what is?

A large Brickbat to the Minister of Health Dr David

Clark who appears to have no understanding of

the meaning of Rules and Regulations.

A large Bouquet for Associate Professor Siouxsie

Wiles for her comments re the Social Media‘s

spreading of false statements on Covid-19, and

the ultra Right Wing statements by certain New

Zealand Radio Hosts. 



Page 19Helping Seniors with Apple Technology http://seniormac.org.nz

Find and Replace — macOS
For those using Pages, Numbers or Keynote, current

versions have made it a little tricky to locate 'Find and

Replace'.

Under the Edit menu FIND is available, however there is

no option for FIND & REPLACE.

Solution

Once you have selected FIND (or pressed Cmd+F) you

will be shown:

To locate the REPLACE look at the additional options:

I believe that once you have selected Find and Replace it will

continue to be displayed each time you access FIND from the

Edit Menu. 

Manage your Files — iPadOS
Open the Files App

Tap and hold on the document or folder of your choice and a

new menu will appear providing many useful options.

These options vary depending on what type of file you are

interacting with:

Quick Tip — iPadOS

Locate ‘Updates’ in App Store app

‘Updates’ no longer has an icon or tab visible at the foot of the

window as soon as the App Store is launched.

However, my Apple ID profile picture now has a red badge

indicating how many apps need updates. Tapping that icon

shows Available Updates near the foot of the new window —

you may need to wait a short time for the Available Updates to

appear.

From this window you can update the apps individually

or tap the Update All option.

There is another way of locating updates that I found to

be quicker on my iPad.

Press and hold on the App Store icon and select Updates.

In addition to the options shown above there is Favourite/

Disfavour if you are looking at a Folder. Use this to include the

folder under Favourites when you use Browse to locate your

TECH
TIPS 6 Tips for macOS and

iPadOS
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files by Location/Favourites/Tags. One option shown in RED

above is: Delete Now.

Tapping this will warn you that the item will be deleted

immediately.

If the option is Delete, it will behave in the way we expect

when using iOS. When you delete a file from iCloud Drive or On

My [device], it goes into your Recently Deleted folder. If you

change your mind or accidentally delete a file, you have 30 days

to get it back. Go to Locations > Recently Deleted. Select the

file that you want to keep and tap Recover.

WARNING: After 30 days, your files are removed from Recently

Deleted and you should consider them GONE.

The Files app provides many of the features available under

macOS, making it possible to easily browse, search, and

organise files in one place. Not just the files on the device

you're using, but also those in iCloud, in Dropbox and other

cloud services. In iPadOS, you can access files on a USB drive,

SD card, hard drive or a file server.

The image above shows even more information available about

the selected file when you tap the Info option. 

Another Quick Tip — iPadOS
Photos app - Editing of Videos - iPadOS13

Time for some discoveries of your own!

Many of the tools and effects that I use on my photos now

seem to be able to be used with videos.

I expect the ability to auto-enhance might be popular. The

ability to rotate videos will also be welcomed. 

Switch to another Wi-Fi Network —

iPadOS
Do you want to change Wi-Fi networks quickly? You don’t need

to go to Settings anymore, now you can do it directly from the

Control Center.

Swipe to access Control Center as usual, then tap and hold on

the Wi-Fi toggle to access a drop-down menu of available Wi-Fi

networks. 

Scan Documents to Files — iPadOS
While I used to scan documents into Notes, it was limited to

doing everything from the Notes app. Now, I can scan

documents from the Files app, where I’d like to store the files,

whether in iCloud, on my iPad, or in a third-party cloud service

such as Dropbox.

The scanner supports some powerful features, including

scanning documents with portrait and landscape pages, as well

as options to scan in colour, grayscale, or black and white. It
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will also compensate for scanning at an angle, skewing the

document so that the final image looks like it was scanned

head-on.

If file size is a concern, the “Black and White” option will

create the smallest size PDF, followed by “Grayscale,” then

“Colour.” The “Photo” option will create the largest files of all

of the options.

The mode options include Auto or Manual. In “Manual,” a blue

or yellow box will appear around the document, and it won’t

scan until you press the shutter button. After that, you’ll have

the chance to fine-tune where the corners of the paper are,

then complete the scan by tapping “Keep Scan” or go back to

the scanning screen by tapping“Retake.”

With “Auto,” iOS will attempt to find the document and

automatically scan it. You’ll know when it finds the document

when you see a blue or yellow box around it, followed by a

small spinning disc and a thumbnail of the image appearing.

You can also force iOS to scan: by tapping the shutter button,

when you can adjust the corners similar to using Manual

mode.

After scanning the first page, you can keep scanning more

documents or pages. The “Save” button in the lower right will

show how many pages have been scanned, which will later be

saved as either a multipage PDF or multiple images. You can

also combine portrait and landscape pages in the same set of

scans, and the final PDF will accurately reflect their

orientation.

you can tap the thumbnail of your scans to open the scan editor.

In the editor, you can swipe between all of the pages and edit

each of them. You can adjust the edges of the document by

tapping the crop tool in the toolbar, change the colour mode, or

rotate counterclockwise.

If your scans look good, you can tap “Save” to finish. But if you

want to make some changes to the colour, crop, or orientation

If any pages look particularly bad, you can tap “Retake” to

rescan just that page, which will replace it while keeping the

pages in the same order in which they were originally scanned.

Alternatively, you can tap the trash can icon to delete any page

completely. When you have finished making edits, tap “Done”

to exit the editor.

When you’ve scanned and edited all of your pages, tap the

“Save” button in the lower right. A new file in your selected

folder will be created named “Scanned Document.” Tap the file

name, and you can change it to something else. Tap “Done”

one more time to save the new name.
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Once you have your file saved, you can treat it like any other

file in the Files app. All of this can be done in one place in iPad

OS.

Below are the options available with a long-tap on 'Scanned

Document'.

BONUS TIP

A great new feature of Mail in iPad OS is very handy! If you are

creating a new message in Mail you can scan a document and

include it within your message.

The document can be a single-page, multiple pages or part of a

page (part of a page is possible as you can crop the image

before accepting the scan). The scanning steps are the same as

those described above.

I have not used a dedicated scanner for 2 or 3-years to

make digital copies of documents such as invoices and

receipts. Before iPadOS I was taking photographs...being

able to scan multiple pages so that related documents are saved

together as one file is a big bonus. 

Compatible with
12.9�inch iPad Pro (3rd and 4th generation)
11�inch iPad Pro (1st and 2nd generation)

Great typing experience
Full�sized, backlit keys and a scissor mechanism for quiet,

responsive typing.

Built�in trackpad
Designed for the new trackpad support and Multi�Touch

gestures in iPadOS.

Floating cantilevered design
Smooth angle adjustability delivers the perfect viewing angle.

Front and back protection

Folds into a case to provide front and back protection for iPad Pro.
Pass-through charging

Powers your iPad Pro and keeps its USB-C port open
for other accessories.

Attaches magnetically
No pairing or charging required — simply attach iPad Pro

and get to work. 

The all-new Magic
Keyboard for

iPad Pro is here
From $NZ 549.00
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Profile
—Cathy and Neil Macpherson

athy and Neil met at University of Canterbury

in 1969—Neil spent his working life as a

Registered Psychologist specialising in
C

Men’s Stopping Violence Programmes and general

counselling. Cathy worked as a Registered Social

Worker, working with women and children and

families.

We both retired 4 years ago and have more time to

Apple denies hackers used flaw to
attack iPhone, iPad user

Apple says it has found "no evidence" a flaw in its email app for

iPhones and iPads has been used against customers, and that it

believes it does "not pose an immediate risk to our users".

San Francisco-based security firm ZecOps on Wednesday detailed a

flaw that it said may have left more than half a billion iPhones

vulnerable to hackers.

Zuk Avraham, ZecOps' chief executive, told Reuters he found

evidence the vulnerability was exploited in at least six cybersecurity

break-ins.

Avraham said he found evidence that an attacker was taking

advantage of the vulnerability as far back as January 2018, but that

he could not determine who the hackers were.

Reuters was unable to independently verify his claim.

Apple on Wednesday acknowledged the vulnerability existed in its

software for email on iPhones and iPads, known as the Mail app, and

said the company had developed a fix that will be introduced in a

forthcoming update to millions of devices it has sold globally.

On Thursday, Apple disputed Avraham's evidence that the hack had

been used against iPhone users.

"We have thoroughly investigated the researcher's report and, based

on the information provided, have concluded these issues do not pose

an immediate risk to our users," Apple said in a statement.

"The researcher identified three issues in Mail, but alone they are

insufficient to bypass iPhone and iPad security protections, and we

have found no evidence they were used against customers."

Avraham did not immediately respond to a request for comment on

Apple's statement. 
Reuters/25 April 2020

enjoy our 3 children and their families, play more

bridge, spend time in the garden and travel. We

joined up with SeniorNet Mac on retirement to

better understand how to use our computers and

iPads and phones. One of our kids is an IT

consultant in Singapore so it’s quite good not having

to bug him every time we have a problem...We have

got a lot out of workshops we have attended and

have made some great friendships along the way.

With the current situation our travelling days may

well have come to an end—we had a trip planned to

Cuba in May which obviously is not happening...very

happy to be in NZ at this particular point in time! 

Thoughts

& Observations
from the Editor during his time in Lockdown

Musings

When out walking—it was much easier to cross the road with

virtually no traffic.

How pleasant it was with the beautiful warm weather—and

how unpleasant it would be if the weather was wet and cold.

With no Sky Sport—binge watching old TV programmes—the

realisation of why there is no-one left alive in Midsomer, is

that they have all been murdered. Dr Quinn, Medicine Woman

was wrongley titled—she stuck her nose into everyones busi-

ness—the title should have been Dr Quinn, Meddling Wom-

an. As for the Andy Griffiths Show—the only Southern town

in the United States where there were no people of colour—

the real star of the show was not Andy Griffiths, it was Don

Knott with his marvelous comic portrail of Barney Fyffe.

Watching re runs of A touch of Frost, with David Jason, how

well it stood up to todays standards that we have now come

to expect.

How living 3 blocks from the sea you could hear the sound of

the surf in our lounge at 10.00pm—there was no traffic noise

to block it.

That I yawned a lot—and at times did not know what day it was.

And that it was nice to see so many tidy gardens, lawns and

berms. 

https://www.newshub.co.nz/home/world/2020/04/apple-to-fix-flaw-in-iphone-ipad-that-left-users-vulnerable-to-hackers.html
https://www.newshub.co.nz/home/world/2020/04/apple-to-fix-flaw-in-iphone-ipad-that-left-users-vulnerable-to-hackers.html
https://www.newshub.co.nz/home/world/2020/04/apple-to-fix-flaw-in-iphone-ipad-that-left-users-vulnerable-to-hackers.html
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Brian the Pirate’s Tip
—Brian Henderson

Unfortunately in these times of lockdown we can't be with our

family and friends, but that doesn't mean you can't communicate

with them and even 'see' them. As long as your relatives and

friends have a computer, an iPad or an iPhone they can use

various apps. such as FaceTime, Skype, Viber and Zoom to

video call them.

The best thing about FaceTime is that it is free to use and

works seamlessly, but only between Mac devices. FaceTime

calls use Wi-Fi or cellular data which is free (rather than

cellular minutes).

This means when you are on FaceTime someone on their iPhone,

even while they are away from home and not connected to Wi-Fi,

nobody pays for the call (as long as there is sufficient data on their

ISP plan) and only a data connection for the duration of the call.

If you feel put off by the idea of a video call then you don’t need

to worry about whether you look your best when you make or

receive a FaceTime call because alternatively you can just use

FaceTime and make an audio call. The benefit here is the

reception is a lot clearer than a typical mobile phone call.

However there are some negatives about using FaceTime

though:

1. You can only use FaceTime to call someone if they have a

Mac or an iOS device which supports FaceTime ie. an

iPhone 4 or later running iOS 4.1 or later, an iPod touch

running iOS 4.1 or later, an iPad 2 or later, or a Mac

running OS X 10.9.2 or later.

2. If the other party doesn’t have an Apple device, you’ll need

to use Skype or another alternative to make a video call.

3. Each person you are calling needs to be signed into FaceTime

and have FaceTime open. FaceTime doesn’t need to be

open on an iPhone or iPad to receive a call.

HOW2 Communicate using

Your Computer and other

Devices

Tip
#1

Tip
#2

Really Useful Timesavers

Updated—Part One

General Tips
The Mac OS X operating system has grown, becoming a highly

capable and multi-layered entity, with many tools and hidden

features just below the surface. This makes the everyday use of

your Mac quicker and easier.

Many third-party applications help to save time when performing

any number of tasks. Often they become embedded within later

system developments. These apps. often range from simple

solutions, like speeding up searching for files or connecting to

other Macs.

Generally, Apple puts the user first when it comes to

designing operating systems, building environments, trying

to get things done more quickly and elegantly.

1. Consistent naming of files
Make a habit of naming all files and folders in a consistent

manner. For example, if it is a letter, name it LETTER, then give

it some reference pertaining to the contents of the letter, such

as “back fence pricing and date it yy/mm/dd. Reason: easily

sorted by order and kind.

Timesavers for everyday Mac use

1. Save time sending files

If you have a group of files or folders that you need to transfer

by email, rather than adding them individually multiple-select

them and choose File > Create Archive. The resulting zip file

will contain all the items and can be added with a single drag

and drop.

2. Find files faster

Select File > New Smart Folder and enter criteria for the

kinds of files the folder should keep track of. eg, ‘all images

opened this month’, making it quicker to find what you want.
3. Save time turning your Mac on and off

In System Preferences > Energy Saver > Schedule, set a

regular time for your Mac to boot up and shut down. For

example, instruct the schedule to start up your Mac just before

you start work.

4. Save time when entering your passwords

Always tick “remember this password” option when

authenticating, so that it is automatically entered for you next

time. Avoid this if you’re on a public Mac or are concerned

about security.

5. Quickly share iCal events online

Email a group of people when you have news of an event.

Create a new calendar in the application. Choose the Publish

option, which will enable you to publish it to either your

iCloud account or send the URL of the calendar to friends or

colleagues so they can opt to subscribe to it. Choose the

publish changes automatically option when you first

publish the calendar and new events, any changes you add will

be automatically pushed to their calendars, meaning no need to

send emails for future events.
6. Speed up repetitive tasks

You can use Automator (in Applications folder) to automate

multi-step tasks by building applications, scripts or plug-ins, eg.

importing, resizing and exporting images from a camera then

mailing them to a predetermined group of people.

7. Send regular email notifications automatically

In iCal, select an event, then from the sidebar’s repeat

menu, choose a frequency such as every week from the repeat

menu. Select Alarm > Send email one day before to your

continued on next page
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Brian the Pirate's Tip
—Brian Henderson

email address. For example, this could used as a reminder to

pay a bill the day before it becomes due every month.

8. Open your applications faster and easier

Use Spotlight search bar (top right in Finder menu) rather

than navigating to the Applications folder. Type in the first

few letters of the program’s name and it will appear almost at

once. To Launch, click on the name.

9. Connect to other computers faster

In the System Preferences > Sharing tab on your Mac, turn

on Personal File Sharing. The Mac will automatically appear

in either the Network tab or the Shared tab in the sidebar of

Macs. If you enable the Apple Remote Desktop option in

the Sharing preferences, you will be able to use the screen-

sharing feature.

10. Quickly open multiple pages in Safari

With multiple pages stored in a folder within the Bookmarks

Bar, if you hold the Command key and click on the folder’s

name, Safari will open all those pages in separate tabs for you.

11. Reveal the Desktop with one click

Hold down Command/Alt and click anywhere on your Desktop.

All active applications will be hidden letting you access items

on the Desktop without having to hide each application

separately.

12. Quickly open programs you always use

In System Preferences > Accounts > Login Items, drag

into the list any items you want to open automatically on login,

such as Mail, saving you time manually loading them.

13. Save time deleting files and folders

Instead of dragging items to the Trash manually, simply select

them and hit Command/Backspace to send them to the

Trash with one click.

14. Save time when downloading images

Simply right-click on an image in Safari or any other

browser and you can then choose to quickly save it onto the

Desktop, into Photo or set it as your Desktop background.

continued from previous page

Part Two will be in the August/September Apple NEWS.

15. Quickly sync the contents of folders for backup

Use Automator to back up the contents of one folder into

another with the click of a mouse. Specify the input and output

folders and backup options and save the workflow. Now the

backup can be performed any time with a single click.

16. Quickly cycle between open applications

Rather than clicking an application’s icon in the Dock, hold

Command and press the tab key to instantly bring up the

application switcher, so that you can move between active

programs.

17. Save time when filling in web forms

In Safari’s preferences, go to the Autofill tab. Here you can

set it to use information from your Contacts card and save

usernames and passwords to make the process of filling in

forms much quicker and less tedious.

18. Save time logging out

To log out as quickly as possible, press Command/Shift/Q

then Enter (Return).

19. Quickly preview music, movies, pictures and text

Select any item and press the space bar to invoke Quick

Look. This will enable you to view movies and music and also

scroll through, read text and PDF documents without having to

open any applications first.

20. Save time when juggling lots of applications

Instead of endlessly moving application windows around, use

Spaces to assign programs to spaces, then switch smoothly

between them.

21. Quickly jump to important folders

Use the Go menu in Finder to access the major folders like

Applications or Downloads with just a single click.

22. Remove unwanted preference panes

If you want rid of a preference pane, go to the System

Preferences > Other section. You can then right-click on a

pane and remove it in a single click.

23. Quickly create PDFs

From any Print dialog in OS X you have multiple options to

save to PDF—much faster than using Acrobat.


